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About This Guide

The IRIX NetWorker User’s Guide contains instructions on how to use NetWorker’s
backup, archive, and recover software from a client workstation.  It also shows how to
back up files and directories to the NetWorker server as needed, using the NetWorker Backup
window, and how to browse the online file index to recover files using the NetWorker Recover
window.  Instructions for using the optional NetWorker Archive Application are also
included in this guide.

For information on server configuration and administration, refer to the IRIX NetWorker
Administrator’s Guide.

Audience

Those who will benefit most from this manual are users and system administrators who
use NetWorker to back up, recover, archive, and retrieve data on a client workstation.

Conventions

This manual uses conventions to make information easy to access and understand.  The
conventions are described in the following list.

• Shell command names and command-line options are displayed in bold typeface.
For example:

To start the NetWorker backup program, use the nwbackup command.

• Displays of text that you need to type are displayed in bold fixed-width typeface.
For example:

# nwbackup &

• Displays of text where you must substitute a variable are shown in italic typeface.
For example:

# nwbackup -s serverName
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• Names of NetWorker buttons, displays, menus, menu items, scrolling lists, and
windows are displayed in Helvetica typeface.  For example:

Click the Cancel button to close the Help window.

• Printing and nonprinting keyboard keys are displayed in Helvetica typeface and
enclosed in square brackets.  For example:

Hold down the [Alt] key and press the shortcut key.

• Directory pathnames, machine names, and new terms defined in the glossary are
displayed in italic typeface.  For example:

When you use NetWorker to back up your files, you are saving them to backup
volumes on the NetWorker server.

• The following symbols indicate various levels of additional information to help you
when using NetWorker:

Caution: Important pieces of information and cautionary notes that prevent you
from making a mistake are marked “Caution.”

Note: Helpful information that you should probably know about is marked “Note.”

Tip: Tips or suggestions that you do not necessarily have to follow, but may give you
hints as to how to set up NetWorker at your site, are marked “Tip.”

Shortcut: Step-by-step procedures that help you save time because they provide the
minimum information you need to complete a task are marked as “Shortcut.”
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Chapter 1

1. Introduction to IRIX NetWorker

IRIX NetWorker is an easy-to-use network storage management software product.
NetWorker performs automatic backups of your files, scheduled by your system
administrator, to protect against the loss of valuable data.  You can also perform backups
on an as-needed basis and archive project-related data for additional protection.

With NetWorker, recovery is fast and convenient, so you do not waste time re-creating
lost files.  Simply scroll through NetWorker’s list of backed-up files and recover the files
to your disk.  NetWorker even shows multiple versions of a file, backed up over time,
allowing you to select the version you want to recover.  NetWorker provides access to
these powerful features through an intuitive graphical user interface (GUI).

The optional NetWorker Archive Application provides the ability to take a snapshot of
finished project files or directories residing on primary media (usually disk).  You can
choose to have archived files automatically removed from disk, after NetWorker verifies
the snapshot is safely stored on removable media, to conserve disk space.

Unlike backed-up data, the media used for storing archived data is never recycled.
Archived data is preserved for as long as you need it.  Archiving data associated with a
finished project frees up space for current projects, while assuring future access to
mission-critical data.

To use the Archive Application, your system administrator simply enables the software
on the NetWorker server and clicks a choice to revise your client setup.  No additional
installation procedures are required.

Overview of IRIX NetWorker

The NetWorker server is a machine with a backup device that automatically backs up all the
systems on a network.  Once your system administrator installs NetWorker and
configures the server to recognize your system as a client, NetWorker

• automatically backs up your files on a set schedule
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• backs up selected files at any time as needed

• provides long-term storage of project data with the optional Archive Application

Figure 1-1 Flowchart of NetWorker Backup and Archive

When you use NetWorker to back up your files, the files are saved to backup volumes on
the NetWorker backup device.  The NetWorker server keeps an online index of the
backed-up files.  You browse this online index to recover a single file or a complete
directory.

Archiving involves long-term storage of data on media called archive volumes.  Archive
volumes are similar to backup volumes, but are stored for very long periods of time and
are not automatically recycled.

About This Guide

This guide contains information on backing up and recovering your data using the
NetWorker Backup and NetWorker Recover windows.  Instructions for using the NetWorker Archive
and NetWorker Retrieve windows (the Archive Application) are also included.

This guide is organized into sections to help you locate the kind of information you need,
including shortcuts, examples, and step procedures.

NetWorker backs up

The NetWorker
server sends

a tape drive

or

autochanger.

tracks your data on backup
regularly stores and

Your system is a

NetWorker client.

your data over the
network.

the data to

NetWorker

NetWorker Archive

volumes.  If you lose a file,
you can get it back
easily and quickly.

stores project data on
archive volumes.  You
can remove files from
your system after
archiving to conserve
disk space.  Mission-
critical data remains
safely preserved for as
long as you need it.
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Using the NetWorker Programs

After the NetWorker server is set up, your system administrator will install two
programs: nwbackup and nwrecover.  The system administrator will install the
software on your system or configure your system to access NetWorker remotely.

If the optional Archive Application is enabled for your site, two additional programs are
available for use: nwarchive and nwretrieve.  The system administrator changes your
client configuration to allow your system to use the Archive Application.

Requirements for NetWorker Clients

Your system administrator is responsible for setting up your system to meet the
requirements for NetWorker clients.

The following conditions must be met for a workstation to qualify as a NetWorker client:

• The NetWorker software is installed.  For installation instructions, see the IRIX
NetWorker Installation and Maintenance Guide.

• The daemon nsrexecd is running on a NetWorker client.  The daemon nsrexecd is
used by savegrp to start saves on NetWorker client machines.  To enable nsrexecd,
the install script nsr_ize must be run on the client.

• The NetWorker server is configured to recognize the client.  For directions on how
to set up a client, see the IRIX NetWorker Administrator’s Guide.

If any one of the above conditions are not met, you will be unable to use NetWorker.
Contact your system administrator before proceeding.
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Quick Tour Review

During the Quick Tour of NetWorker, you learned how to perform the following tasks:

• Use the NetWorker GUI.

• Use the NetWorker Backup window to back up a subdirectory to the NetWorker server.

• Exclude a file from the backup.

• Monitor the status of the backup.

• Use the NetWorker Recover window to browse the index for your backed-up files.

• Mark a file for recover in the Recover window.

• Recover a file.

• Use the Conflict Resolution dialog box to resolve naming conflicts during recover.

• Monitor the status of the recover.

The Quick Tour is meant to familiarize you with the NetWorker Backup and NetWorker Recover
windows.  Chapter 3 shows how to view and mark your files and directories.  Chapter 4
provides detailed information on performing backups and recovers.

If you have the optional NetWorker Archive Application, see Chapter 5, “Archiving and
Retrieving Files” for information specific to the NetWorker Archive and NetWorker Retrieve
windows.
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Figure 2-29 Recover Status Window

The Recover Status dialog box provides the following information:

• number of files to recover and their recover location

• estimated disk space needed

• name(s) of the backup volumes needed

• device location of the required backup volume(s)

• number of files being recovered and their names

• new filenames, if you selected Rename the recover file

Click the Cancel button to cancel the recover or close the Recover Status dialog box when the
recover is finished.

A message similar to the following appears when the file recover completes:

Recover completion time: Wed Apr 17 15:21:17 1996
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1. Click the Start speedbar button to start the recover.  The Conflict Resolution dialog box
appears, as shown in Figure 2-28.

Figure 2-28 Conflict Resolution Dialog Box

Use the Conflict Resolution dialog box to resolve naming conflicts that might occur
during recovery.  Naming conflicts occur when the requested recover file has the
same name as an existing file.

2. Click No for Do you want to be prompted when conflict occurs?, so that NetWorker does not
prompt you for each naming conflict.

3. Click one of the When conflict occurs, NetWorker should? choices.  The default choice, Rename
the recover file, is already selected.  This option adds a .R extension after the name of
the recovered file when a naming conflict occurs.

Tip: We recommend you select the default choice, Rename the recover file, to ensure that
existing files are not accidentally overwritten.

4. Click Ok to close the Conflict Resolution dialog box and continue the recover.

The Recover Status window appears, as shown in Figure 2-29, so you can monitor the
recover process.

5. Confirm your file recover by listing the contents of the directory from a UNIX®

command prompt.  Since Rename the recover file was selected in the Conflict Resolution dialog
box, the recovered file shown in the example has a .R file extension.
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1. Notice that the current directory is highlighted.

2. Select Expand One Level from the Tree pulldown menu.

The subdirectories are displayed in a tree structure in the directory display, as
shown in Figure 2-26.

Figure 2-26 Recover Directory After Expanding One Level

Tip: Double-clicking a closed directory folder expands it one level.  Double-clicking an
open directory folder collapses it.

Marking a File

To mark a file or directory for a recover:

1. Click the directory folder that contains the file you want to recover.  The file display
shows the most recently backed-up version of the files contained in the directory.

2. Click the checkbox in the file display next to the file you want to recover, as shown
in Figure 2-27.  If you want to recover an entire directory, mark its checkbox in the
directory display.

Figure 2-27 File Marked for Recovery With Check Mark

Starting the Recover

So far, you have browsed the index and marked files for recovery.  The next step is to start
the recover.
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Figure 2-25 NetWorker Recover Window

Note: The NetWorker Recover window displays index entries for the files on the NetWorker
server.  By contrast, the NetWorker Backup window displays the actual files in your
filesystem.  The NetWorker Recover window shows entries for files that have been backed up
and are available for recovery.  The entries are organized exactly like an actual filesystem,
so it is easy for you to navigate the directories.

Browsing the Index

You can browse the index to locate a file you want to recover.
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Recovering a File

The NetWorker Recover window displays the index entries NetWorker creates when it backs
up the data on your system.  Index entries are organized exactly like the filesystem
displayed in the NetWorker Backup window, so you can easily navigate through your
directories and files.

The Quick Tour takes you through the following steps to practice recovering a file:

• opening the NetWorker Recover window

• browsing the files contained in an index

• marking the files you want to recover

• starting the recover

Opening the NetWorker Recover Window

Click the nwrecover icon (shown in Figure 2-24) to open the NetWorker Recover window, or type
the nwrecover command at the system prompt.

Figure 2-24 NetWorker Recover Icon

The NetWorker Recover window appears, as shown in Figure 2-25.
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Figure 2-23 Backup Status Window

Tip: If you do not see files scrolling in the display, or if an error message appears, contact
your system administrator.  The server may be busy, or could have a configuration
problem, or a backup volume might not be mounted in the device.

When your backup is complete, you see a message similar to the following in the Backup
Status dialog box:

Backup Completion Time: Fri Nov 3 14:20:42 1995

NetWorker backs up marked files to the volume mounted in the server backup device.
NetWorker also creates an entry in the index for each file it backs up, so you can find
them for quick recovery.

Click the Cancel button to close the Backup Status window.  Click the minimize button in the
window header to reduce the NetWorker Backup window and display the nwbackup icon.  If you
want to exit NetWorker (stop the program), select Exit from the File menu.
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Starting the Backup

After you finish marking files, you are ready to start the backup.  Click the Start speedbar
button to start the backup.

Before the backup starts, the Backup Options dialog box appears, as shown in Figure 2-22.

Figure 2-22 Backup Options Dialog Box

Tip: You can exclude groups of files by entering UNIX shell pattern matching characters
in the Backup Options dialog box.  For information on excluding patterns, see Chapter 4,
“Backing Up and Recovering Files.”

Use the Backup Options dialog box to tell NetWorker whether or not to compress the files
during backup.  The default choice for Do you want to compress this backup? is already
highlighted, as shown.  Click the Ok button to continue the backup with file compression.

Note: Compressing your data during backup saves space on the backup media and
reduces network traffic, but may slow down the backup operation.  Check with your
system administrator to find out if you should compress your data during a backup.

The Backup Status window appears, as shown in Figure 2-23, so you can monitor the backup
process.
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Tip: You can also mark a directory by clicking its folder in the directory display and
clicking the Mark speedbar button. The effect is the same as clicking the checkbox next to
its folder.

Excluding a File From the Backup

You can exclude a file from backup by unmarking it.  Click the checkbox next to a file to
unmark it in the file display.  The check mark disappears, excluding the file from backup,
as shown in Figure 2-21.

Figure 2-21 Backup Window After Mark and Unmark

Tip: You can also unmark a file by clicking its folder in the file display and clicking the
Unmark speedbar button.  The effect is the same as clicking the checkbox next to its folder.
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Marking a Subdirectory

To mark a subdirectory, click the checkbox next to the folder representing the
subdirectory you want to back up.  A check mark (✓ ) appears in the checkboxes, as
shown in Figure 2-20.

Click the folder to display its files.  In the file display, the files and subdirectories
contained in the marked subdirectory also appear marked, as shown.

Figure 2-20 Backup Window Checked after Mark

When you mark a directory, its nested files and subdirectories are marked as well.  The
checkboxes of the parent directories are shaded to indicate that a subdirectory has been
marked.
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Figure 2-18 Tree Menu, Expand One Level Option

The directory display changes to show the expanded directory, one level below, as shown
in Figure 2-19.

Figure 2-19 Backup Window, Expanded One Level
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Figure 2-17 NetWorker Backup Window

The Selection field displays the pathname of the directory where you originally started
NetWorker.  The directory display shows a graphical representation of the path with the
current directory highlighted.  A highlighted directory is represented as a shaded folder
icon in the display.  The file display shows the contents of the current directory.  A
highlighted file is displayed as a shaded sheet icon.

Expanding the Current Directory

Expand the current directory one level to find a subdirectory to mark for backup.  Select
Expand One Level from the Tree menu (see Figure 2-18).
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Quick Tour of NetWorker

Follow the instructions in this section to become familiar with how NetWorker
functions.  The “Quick Tour” shows how to back up your current directory and recover
a file using NetWorker.  Chapters 3 and 4 provide detailed information about using
NetWorker.  Chapter 5 provides detailed information about using the optional
NetWorker Archive Application.

Backing Up Your Directory

The NetWorker Backup window displays a graphical representation of the path with the
current directory highlighted.  The NetWorker Backup window lets you browse the filesystem
to examine your directories and decide which files to mark for backup.

The Quick Tour takes you through the following steps to practice backing up a file:

• opening the NetWorker Backup window

• expanding the current directory

• marking an entire subdirectory for backup

• excluding a file from the backup

• starting the backup

Opening the NetWorker Backup Window

Click the nwbackup icon (shown in Figure 2-16) to open the NetWorker Backup window, or type
the nwbackup command at the system prompt.

Figure 2-16 NetWorker Backup Icon

The NetWorker Backup window appears, as shown in Figure 2-17.
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In the file display, sheet icons represent files, while folder icons represent directories (see
Figure 2-12).

Figure 2-12 Sheet Icon Representing a File

Shaded sheets indicate selected files, and chain icons represent symbolic links (see
Figure 2-13).

Figure 2-13 Chain Icon Representing Symbolic Link

Brick icons represent block devices, while three-box icons represent character devices
(see Figure 2-14).

Figure 2-14 Brick and Three-Box Icons for Devices

The clock or watch icon replaces the cursor when NetWorker is busy performing a task.

Exiting From a Window

The Exit menu item is in the File menu of all NetWorker windows (see Figure 2-15).
Selecting the Exit item closes the current window, without backing up or recovering files,
and quits the current window.

Figure 2-15 File Exit Menu
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Icons

Use the checkbox next to an icon to mark and unmark files and directories for backup or
recover.  The icons you see in the window are described below.  (Some of the icons
represent terms common to UNIX.)

Folder icons represent directories (see Figure 2-7).

Figure 2-7 Folder Icon for Directory

Open folder icons indicate that the tree structure of the directory, if any exists, appears in
the directory display (see Figure 2-8).

Figure 2-8 Open Folder Icon for Directory Tree

A check mark in the checkbox next to a folder icon for a subdirectory indicates that it is
marked for backup or recover (see Figure 2-9).

Figure 2-9 Check Icon for Directory Tree Mark

Shaded folder icons indicate a directory selected for menu actions.  The folder contents
appear in the file display (see Figure 2-10).

Figure 2-10 Shaded Icon for Selected Directory

Folder icons with the red root-system represent mount points (see Figure 2-11).

Figure 2-11 Root-System Icon for Mount Points
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• Search—searches for specific directories or files

• Start—starts the backup or recover operation

Figure 2-6 NetWorker Speedbar Buttons

The speedbar is identical in the NetWorker Backup, NetWorker Recover, and NetWorker Archive
windows.  Clicking a speedbar button produces the same result as selecting the menu
item from a pulldown menu.

Selection Panel

The selection panels in the NetWorker Backup, NetWorker Recover, and NetWorker Archive windows
show the current server and client selected.  The selection panel in the NetWorker Recover
window also displays the current Browse Time.

The Selection field shows the full pathname of the currently selected file or directory.  Enter
text in the Selection field or click a directory or file icon to select a different pathname.

Directory and File Display Areas

The window is divided into two display areas:  a directory display on the left side and a
file display on the right side.  Both display areas contain vertical and horizontal
scrollbars that allow you to view complete directory and file information. You can adjust
the window to fit more information in the display areas.  The display areas contain icons
that represent the files and directories in the path you select.

Window Controls

Navigate vertically or horizontally in the directory and file displays by clicking the
triangular endpoints on the scrollbars, or by dragging the slider.
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Figure 2-5 Backup Help Window

To return to the NetWorker Backup window, click the Cancel button.

Speedbar

The five graphical buttons that appear on the speedbar (see Figure 2-6) serve as shortcuts
for the following menu items:

• Change Server—switches to a different NetWorker server

• Mark—marks directories or files

• Unmark—unmarks directories or files
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Figure 2-4 Topics Help Window

To see more information about a topic, click its title in the Topics scrolling list.  Help text
for the selected topic appears at the top of the dialog box.  The Topics scrolling list remains
available in the bottom panel for selecting other topics.

For example, clicking the topic Backup produces the dialog box shown in Figure 2-5.
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• To pull down a menu using keyboard shortcuts:

1. Hold down the [Alt] key.

2. Press the key that matches the underlined letter of the menu name.

3. Release both keys, then press the key that matches the underlined letter in the
menu item name.

Note: The left and right mouse button actions used in this manual are X Window System
defaults.  If you have problems using the mouse, your mouse buttons may be
programmed differently.  See your system administrator for help.

Online Help

Select the online Help menu, available in any NetWorker main window, for help on using
NetWorker.  Online help is available for components of the selected window, menu
items, and dialog boxes.

The Help pulldown menu (see Figure 2-3) provides choices that provide help on the
current window, a list of help topics to browse, directions for using Help, and information
about the version of NetWorker you are using.

Figure 2-3 Help On Topic Menu Choice

Select the On Topic menu item in the Help pulldown menu to open the Topics Help dialog box,
as shown in Figure 2-4.
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Figure 2-2 NetWorker Backup Window Vocabulary

Menu Bar

The menu bars in the NetWorker Backup and NetWorker Recover windows contain the File, Tree, View,
Change, Mark, Options, and Help pulldown menus.  There are two choices for navigating
NetWorker menus.  You can use the point-and-drag method with a mouse, or you can
use the keyboard shortcuts.

• To pull down a menu using a mouse, move the mouse so its arrow points to your
menu choice.  Hold down the primary mouse button (usually on the left); the menu
appears.  With the mouse button still held down, drag the mouse arrow to the item
in the menu, then release the button to make your choice.

Menu bar

Speed bar

Selection panel

Mount point icon

Highlighted directory

File icon

Directory display

File display
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If you have a multi-server network and do not specify a server name, NetWorker chooses
a backup server for you.

Tip: You can start NetWorker from any directory.  The directory where NetWorker starts
is the location shown in the NetWorker Backup or NetWorker Recover directory display.

If you receive an error message while starting NetWorker, there may be problems with
your network configuration.  Refer to “Requirements for NetWorker Clients” on page 3
to confirm that your system is configured correctly as a NetWorker client.  If you need
further help, contact your system administrator.

Using NetWorker Windows

NetWorker displays your files and directories using icons and windows.  NetWorker
windows provide an easy-to-use X Window System™ graphical user interface (GUI).
This section shows you how to use NetWorker windows.

Window Components

Figure 2-2 shows the NetWorker Backup window and its components.



5

Chapter 2

2. Getting Started

This chapter describes how to start the NetWorker programs and navigate their
windows.  It provides a Quick Tour using NetWorker to back up and recover files from
a client system.  To use NetWorker, your system must be configured as a NetWorker
client.  See “Requirements for NetWorker Clients” on page 3, for details on the
requirements for NetWorker clients.

If your site has the optional NetWorker Archive Application, be sure to read Chapter 5,
“Archiving and Retrieving Files,” for information on using the program windows.

When NetWorker is running on your system, you can see the NetWorker icons or the
NetWorker Backup and NetWorker Recover windows on your screen (see Figure 2-1).  The program
icons include the “NetWorker knight” and a caption.  If you see these, click an icon to
open the program window.

Figure 2-1 NetWorker Icons for Backup and Recover

If you do not see the NetWorker icons or the windows on your screen, start NetWorker
from the command line on your system.

Starting NetWorker

To start NetWorker from the command line, enter either the nwbackup or nwrecover
command, specifying a NetWorker server name after the -s option.  Use an ampersand
(&) to run NetWorker in the background:

# nwbackup -s server_name &
# nwrecover -s server_name &



27

Chapter 3

3. Browsing Filesystems

This chapter shows how to browse filesystems in the NetWorker Backup, NetWorker Recover, and
NetWorker Archive windows.  NetWorker filesystem displays allow you to view directories,
mark and unmark files, search for files, view file details, and change the current directory
displayed.  When recovering files, the index of saved files is displayed exactly like your
filesystem, making it convenient to select files for recover.

Note: This chapter describes browsing features common to all three windows.  Features
specific to the NetWorker Backup and NetWorker Recover windows are described in Chapter 4,
“Backing Up and Recovering Files.”  See Chapter 5, “Archiving and Retrieving Files,” for
features specific to the NetWorker Archive and NetWorker Retrieve windows.

Viewing Your Directories

The Tree menu (Figure 3-1) contains three choices for changing the level at which you
view directories in a filesystem:  Expand One Level, Expand Branch, and Collapse Branch.  You can
expand a directory one level to view its subdirectories, or expand a branch to view all
levels of a directory.  This makes it easy to find files deeply embedded in your filesystem.

Figure 3-1 Tree Menu

Expanding One Level

The Expand One Level menu choice displays the subdirectories one level below the selected
directory.  Subdirectories are graphically displayed as a tree structure.  You can scroll the
directory display to find the subdirectory containing the file you want.



28

Chapter 3: Browsing Filesystems

To expand a directory one level:

1. Click a directory folder in the directory display.

2. Choose Expand One Level from the Tree menu or double-click the directory folder.

Expanding a Branch

The Expand Branch menu choice displays all levels of subdirectories contained in a directory.

To expand a directory to view its branch:

1. Click a directory folder in the directory display.

2. Choose Expand Branch from the Tree menu.

Note: Large directories and branches might take longer to expand.

Collapsing a Branch

The Collapse Branch menu choice closes all subdirectories and returns you to the level of the
highlighted directory.

To collapse a branch (close all subdirectories):

1. Click an expanded directory in the directory display.

2. Choose Collapse Branch from the Tree menu, or double-click the directory folder.

Marking and Unmarking Files

You choose files and directories for backup and recover by marking them.  The icons
have a checkbox beside them that displays a check mark when the file is marked.  To
mark or unmark files and directories, use the Mark and Unmark speedbar buttons or click the
checkbox next to the file or directory (see Figure 3-2).

Figure 3-2 Mark and Unmark Buttons, Marked Folder
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To mark (or unmark) a file or directory using the speedbar buttons:

1. Click a file or directory icon.

2. Click the Mark speedbar button.  This places a check mark in the checkbox beside the
highlighted icon, marking it for backup or recover.

3. Click the Unmark speedbar button to remove the check mark.  This removes the check
mark and excludes the file from the backup or recover.

Note: If you click the Mark or Unmark button without first selecting a directory or file
icon, the directory displayed in the Selection field is the one marked or unmarked.

To mark (or unmark) a file using the checkbox next to the file icon:

1. Click the checkbox next to the file.  This places a check mark in the checkbox.

2. Click the checkbox to unmark a marked file.

Tip: Marking a directory also marks its subdirectories and nested files.  The
checkboxes of parent directories are shaded to show that some or all of the directory
contents are marked for backup or recover.

Viewing Your Files

The View pulldown menu contains commands for searching directories for specific files
and for changing the level of detail displayed for the directories and files.

Searching for Files

If you know the name or partial name of a file or directory, you can use the Search
command to locate it in the filesystem or index.  Use the Search speedbar button to bring
up the Search dialog box, or choose Search from the View menu, as shown in Figure 3-3.

Figure 3-3 View Menu and Search Button
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To search for a file, specify the filename or partial filename and the pathname where you
want to begin the search.  NetWorker begins searching in that directory, then searches
through the subdirectories and nested files within the path.  To search for directories or
files by name:

1. Click the Search button in the speedbar to open the Search dialog box or choose Search
from the View menu.  The Search dialog box appears, as shown in Figure 3-4.

Figure 3-4 Search Dialog Box

2. Enter the name of the file or directory in the Search for field.  You can use standard
UNIX shell pattern matching characters when specifying partial filenames.

3. Enter a valid pathname for the desired directory in the Begin search in field.  NetWorker
searches through that directory and all nested subdirectories.

4. Click the Ok button.  The pathname of the first match appears in the Selection field and
is also highlighted in the file display.

5. Click the Continue button to highlight the next match and display it in the Selection
field.  You can continue the search until NetWorker finds the last match.

If NetWorker cannot find a match for the selection, a dialog box message appears, as
shown in Figure 3-5.  Click OK to close the dialog box.

Figure 3-5 Search No Match Notice

6. Click the Cancel button to close the Search dialog box.
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Viewing File Details

You can choose to view filenames only or complete file details in the file display by
choosing the File Details item in the View menu, as shown in Figure 3-6.  Clicking the button
for this command toggles between the two choices.

Figure 3-6 View File Details Menu

The default viewing selection displays filenames only, listed in alphanumeric order.  The
File Details choice changes the view to display the filename, number of blocks, permissions,
number of symbolic links and where they point, owner, group, size, date, and time each
file was last modified.

In the NetWorker Recover window, the File Details choice also displays the backup time for each
file.  Use this information to identify different backup versions of a file.

To display file details:

1. Choose File Details from the View menu.  The file display in the NetWorker Recover window
changes to show file details.  In Figure 3-7, notice the Backup time listed for each file.

Figure 3-7 File Details Listed in File Display
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2. Adjust the size of the window or use the horizontal scrollbar at the bottom of the file
display, if necessary, to display the contents of the window.

To return the file display back to filenames only, click the File Details choice once more.

Changing a Selection

The NetWorker Backup, NetWorker Recover, and NetWorker Archive windows display the full pathname
of the current directory in the Selection field.  If you know the path of a directory or file,
you can go directly to it by entering the full pathname in the Selection field.

To change the current selection:

1. Enter the full pathname for the new selection into the Selection field, as shown in
Figure 3-8.

Figure 3-8 Selection Field in NetWorker Window

2. Press the [Enter] key.

Both the directory and file displays change to show the new selection.
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4. Backing Up and Recovering Files

This chapter describes the NetWorker Backup and NetWorker Recover windows.  It includes the
backup and recover functions unique to each window.

For information on using functions common to both windows, see Chapter 3, “Browsing
Filesystems.”  For a quick tour of the backup and recover programs, see Chapter 2,
“Getting Started.”  If your site has the optional NetWorker Archive Application, be sure
to read Chapter 5, “Archiving and Retrieving Files.”

Backing Up Files

This section assumes that you already know how to mark files for a backup.  For detailed
instructions on viewing directories, marking and unmarking files, searching for files, or
viewing file details, see Chapter 3, “Browsing Filesystems.”

If you are already familiar with the NetWorker Backup window, see the shortcut instructions
on page 39.

Changing the NetWorker Server

NetWorker backs up your data according to a backup schedule determined by your
system administrator.  Usually, a single NetWorker server backs up all the systems on a
network.  You may need to change servers if your NetWorker server is down or you are
experiencing network difficulties.

If you have more than one NetWorker server available on the network, you may have a
choice of servers for backups.  In order to switch to a different NetWorker server, your
system must be listed as a client of that server.  Check with your system administrator
before you switch to a server other than the one that normally backs up your system.

To change NetWorker servers:
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1. Click the Change Server speedbar button, or choose Server from the Change menu in the
NetWorker Backup window, as shown in Figure 4-1.

Figure 4-1 Change Server Button and Menu

The Change Server dialog box appears, as shown in Figure 4-2.

Figure 4-2 Change Server Dialog Box

2. Enter the hostname of the server in the Server field or click a name in the list of servers
displayed.

If you do not see the hostname of the server you need, click the Update Server List
button to update the list of NetWorker servers available on your network.

Caution: When you click the Update Server List button, NetWorker searches for every
server available to your machine.  If you have a large network, this search could take
awhile.

3. Double-click the hostname to choose the new server or click Ok to choose the server
shown in the Server field.

Note: If you choose a NetWorker server that does not have your system listed as a
client, you receive a notice similar to that shown in Figure 4-3.  If this occurs, locate
another server, or contact your system administrator.
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Figure 4-3 Notice for Client Not Registered

Starting a Backup

Use the Start speedbar button to start a backup on marked files or choose Start Backup from
the File menu, as shown in Figure 4-4.

Figure 4-4 Start Backup Menu and Button

To start a backup:

1. Mark the files you want to back up.

2. Choose the NetWorker server (if necessary).

3. Click the Start speedbar button.

The Backup Options dialog box appears, with choices for the options NetWorker applies
to your backup.

Choosing the Backup Options

NetWorker displays the Backup Options dialog box before starting the backup.  This gives
you the opportunity to compress files and exclude patterns before the backup starts.
Compressing data reduces network traffic and saves space on the backup media.
Excluding patterns is convenient for specifying data you do not want to back up at all.
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Compressing Files

To choose whether to compress the files you back up, select a choice for Do you want to
compress this backup? in the Backup Options dialog box.  Notice that Yes is already highlighted as
the default selection, as shown in Figure 4-5.

Figure 4-5 Backup Optione Dialog Box

If you want NetWorker to compress your files during backup, you do not have to make
a selection for the compression option, since Yes is the default selection.

If you back up to a device that compresses data, do not use the NetWorker file
compression feature.  Click No to continue the backup without file compression.

Tip: Compressing data during backup saves space on the backup media and reduces
network traffic, but may slow down the backup operation.  Check with your system
administrator to find out if you should compress backup data.

Notice that No is highlighted as the default selection for the Do you want to exclude any patterns
from this backup? choice.  If you do not want to exclude patterns of filenames from the
backup, click Ok to continue the backup.

Excluding Patterns

You can exclude files from a backup using the Pattern options provided in the Backup Options
dialog box.  This feature is useful, for example, if you are backing up an entire directory
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and do not need to back up certain files or subdirectories in that directory.  Excluding
files from the backup also reduces network traffic and saves space on backup media.

To exclude files from the backup, specify alphanumeric patterns that occur in the names
of the files you want to exclude.  Use UNIX shell pattern-matching characters to specify
any number of patterns you want to exclude. To exclude patterns from the backup:

1. Click Yes for the Do you want to exclude any patterns from this backup? choice.  This activates the
lower half of the Backup Options dialog box.

2. Enter the first pattern in the Pattern field.

3. Click Add to add the pattern to the list.  The pattern appears in the pattern list
display, as shown in Figure 4-6.

Figure 4-6 Backup Options, Excluding Patterns

If you want to change a pattern, select it in the pattern list.  The selected pattern
appears in the Pattern field.  Enter the new pattern and click Change.  The new pattern
replaces the old pattern in the pattern list.

If you want to delete a pattern, select it in the pattern list and click Delete.

4. Enter any remaining patterns and add them to the pattern list.

5. Click Ok to continue the backup with the excluded file patterns and the compression
choice.
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Monitoring the Backup Status

The Backup Status dialog box appears after you complete your selections in the Backup Options
dialog box and click Ok.  Use the Backup Status window to monitor the backup process.

Figure 4-7 Backup Status Window

The Backup Status dialog box provides the backup start time and the backup completion
time.  The names of the files and directories scroll across the Backup Status dialog box as the
backup proceeds.

The message at the bottom of the dialog box gives you information about the backup,
including the full pathname of the directory, the amount of data, the amount of time it
took, and the number of files saved.

If you do not see any progress messages in the Backup Status dialog box after a few minutes,
the NetWorker server probably needs attention from the system administrator.  Click the
Cancel button to cancel the backup.
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A message similar to the following appears in the Backup Status dialog box when the
backup completes:

Backup completion time: Fri Nov 3 14:20:42 1995

Click the Cancel button to close the Backup Status dialog box.

Backup Shortcut

Read this section if you are already familiar with the NetWorker Backup window.

To back up your directories or files:

1. Click the nwbackup icon to open the NetWorker Backup window.

2. Click the checkboxes, or highlight the directory or file you want to back up, and
click the Mark speedbar button.

3. Click the Start speedbar button.

4. Click the Ok button in the Backup Options dialog box.

5. Click the Cancel button in the Backup Status dialog box to close it after you check the
backup completion message to make sure the backup is finished.

Recovering Files

This section assumes that you have already marked recovery files in the NetWorker Recover
window.  For detailed instructions on viewing directories, marking files, searching for
files, or viewing file details, see Chapter 3, “Browsing Filesystems.”  If you are already
familiar with the NetWorker Recover window, see the shortcut instructions on page 53.

NetWorker displays entries in the NetWorker Recover window for the files it saved during a
backup.  Select the files you want to recover from this list of entries.  NetWorker recover
functions allow you to browse the index for previous backups, select various versions of
the file to recover, view your marked files, relocate files upon recovery, and recover files
from another authorized system.

Note: An authorized system is a client for which you have permission to recover data.
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Starting a Recover

Use the Start speedbar button to start a recover on marked files or choose Start Recover from
the File menu, as shown in Figure 4-8.

Figure 4-8 Start Recover Menu and Button

Before starting a recover, read the following sections explaining the treatment of naming
conflicts during NetWorker recovery:

• “Relocating Files” on page 50

• “Renaming or Overwriting Recovered Files” on page 50

Choosing the Recover Server

Normally you recover files from the NetWorker backup server designated by your
system administrator.  If you changed backup servers in the NetWorker Backup window, you
must select the same server in the NetWorker Recover window to recover files backed up to
that server. xx

Caution: The Change Server dialog box lists all the NetWorker servers on the network.  You
can back up and recover files only from a server that lists your system as a client.

To choose a recover server in the NetWorker Recover window:

1. Click the Change Server speedbar button, or choose Server from the Change menu.

The Change Server dialog box appears, as shown in Figure 4-9.
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Figure 4-9 Change Server Dialog Box, Updated

2. Click the Update Server List button to update the list of NetWorker servers on the
network, if needed.  Double-click the server name to choose the server that has the
files you need to recover.  The Server field changes to reflect the current selection.

3. Click the Ok button after you select a server.

NetWorker updates the directory and file displays in the NetWorker Recover window.

Note: Select the recover server you want before marking the files to recover.

Choosing the Recover Client

If you need to recover files for a client other than the system currently in use, choose
Change Client from the Change menu.  The Change Client command opens a dialog box that lists
all of the clients for the currently selected NetWorker server.  Check with your system
administrator if you want to recover files other than your own.  You may not be
authorized to recover files for other client systems.

To choose a recover client:

1. Choose Client from the Change menu in the NetWorker Recover window.

The Change Client dialog box appears, as shown in Figure 4-10.
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Figure 4-10 Change Client Dialog Box

2. Click the Update Client List button to update the list of NetWorker clients available on
the selected server.

3. Choose a client for which you are authorized to recover files.  The Client field changes
to reflect the current selection.

4. Click the Ok button after you select a client.

Selecting File Versions

The View pulldown menu in the NetWorker Recover window contains two choices not found
in the NetWorker Backup window: Versions and Volumes.  Information about the Volumes choice is
in “Listing the Backup Volumes for a Recover” on page 48.

The Versions dialog box lists all the versions of a file or directory that have been backed up
by the NetWorker server.  The dialog box also lists the backup volumes on which the files
reside.  Use the Versions choice to view the backup history of a file and to mark a particular
version of a file for recovery.

Caution: NetWorker displays versions of backed-up files and directories in the Versions
dialog box.  You can only mark files for recovery in the Versions dialog box.  If you attempt
to mark a directory in the Versions dialog box, you receive a warning similar to that shown
in Figure 4-11.
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Figure 4-11 Marking Directories in Versions Window

In addition to providing the backup time and location of all backed-up versions of the
selected file, the Versions dialog box provides the following information:  number of
blocks, mode, permissions, number of links, owner, group, size in bytes, and last
modified time.  The filename, including the complete path, is displayed at the top of the
dialog box.  To identify different versions of a file, compare the Backup time indicated for
each version.

The Location field includes the name of the backup volume and the device where the
volume is mounted or the location of the backup volume (for example, offsite storage).
If no device is listed, it means that the backup volume must be mounted before you can
recover the file.

To view the backup history of a file or directory in the NetWorker Recover window:

1. Click a file or directory in the file display.

2. Choose Versions from the View menu, shown in Figure 4-12.

Figure 4-12 View Versions Menu

NetWorker retrieves several versions of the highlighted file or directory from the
index and lists them by backup time, beginning with the most recent (as shown in
Figure 4-13).  Use the scrollbars to view the complete backup history.
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Figure 4-13 Versions Window Showing Backups

3. Click More to retrieve additional versions from the index.  The More button becomes
inactive after all versions are retrieved.

To mark a version of a file for recovery:

1. Click the checkbox of the file version you want to recover.

2. Click Ok to place the marked versions in the file display.

Tip: When you mark a past version of a file in the Versions dialog box, it appears in the
NetWorker Recover window file display with the same name as the most recent version.
Choose File Details from the View menu to display backup times and distinguish the
multiple file versions displayed.
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Changing the Browse Time

The Browse Time field, shown on the bottom right of Figure 4-14, displays the date and time
you started the current NetWorker recover program session.

Figure 4-14 Browse Time in NetWorker Window

The NetWorker Recover window displays the index entries for files backed up at the time
shown in the Browse Time field.  Choose Browse Time from the Change menu to modify the
browse time displayed to another date.  Changing the browse time displays the entries
for files backed up immediately before the new browse time.

Note: If there are no entries for files backed up for the selected time in the Browse Time field,
NetWorker displays files that were backed up closest to that time, but not immediately
after.  For example, if you change Browse Time to 10 a.m. on May 15, and the backup took
place at 11 a.m. on May 15, NetWorker will not display the entries for the files backed up
at 11 a.m.

Changing the browse time lets you view past versions of your files.  This is useful if you
do not remember the name or location of the files you want to recover, but do remember
they existed at some time in the past.  The Browse Time choice in the Change menu also helps
you find deleted files that no longer appear in the Versions dialog box.  You can recover
deleted files by changing the browse time to locate past versions of the files in the index.

Note: Use the Browse Time choice to browse and mark past versions of directories.
Marking a directory causes all its nested files and subdirectories to be marked.
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To change the browse time to recover a past version of a file:

1. Choose Browse Time from the Change menu in the NetWorker Recover window, shown in
Figure 4-15.

Figure 4-15 Change Browse Time Menu

The Change Browse Time dialog box appears, as shown in Figure 4-16.

Figure 4-16 Change Browse Time Dialog Box

The Previous, Today, and Next buttons control the month displayed.  After choosing a
month, click a day in the calendar to select the browse time.

Note: You can also change the browse time by entering a valid date and time in the
Browse Time field and pressing [Enter] or clicking Ok.  The following formats are valid
browse time entries:
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• last Friday, next Friday, third Friday

• now (the current date and time)

• + or – 3 seconds, minutes, hours, weeks, months, or years

• hh:mm:ss (24 hour clock) or
hh:mm:ss (am or pm) mm/dd/(yy) or
month dd (yy)

2. Click Ok after choosing a browse time.  The Browse Time field in the NetWorker Recover
window changes to reflect the new browse time.  The file display and directory
display of the NetWorker Recover window show files that were backed up at or before
that time.  You may now mark past versions of files for recovery.

Note: Any files or directories you marked for recovery before changing the browse
time remain marked.

Showing Marked Files

List the files you marked for recovery by choosing Show Marked from the Mark menu.  This
command is available only in the NetWorker Recover window.  Use the Show Marked command
to review files marked for recovery before starting the recover operation.

To show the files marked for recovery:

1. Choose Show Marked from the Mark menu of the NetWorker Recover window, as shown in
Figure 4-17.

Figure 4-17 Show Marked Menu Choice

The Files Marked for Recovery window appears, listing the pathnames and backup time of
all marked files, as shown in Figure 4-18.
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Figure 4-18 Files Marked for Recovery Window

2. Click Cancel to close the window.

Tip: The Files Marked for Recovery window lets you verify that all the files you need to
recover are marked before starting the recover.

Listing the Backup Volumes for a Recover

After you mark your files for a recover, you can find out if the backup volumes
NetWorker needs are available.  If NetWorker cannot access the backup volume
containing your file, it sends a message to the system administrator to load the volume.
This request could take some time to fulfill.  You may want to delay the start of the
recover until the volume is available.

Choose Volumes from the View menu, as shown in Figure 4-19, to determine if the backup
volume needed to recover a file is available.



Recovering Files

49

Figure 4-19 View Volumes Menu Choice

To determine if the file you want to recover is immediately available for recovery:

1. Mark the files or directories you want to recover in the NetWorker Recover window.

2. Choose Volumes from the View menu.

NetWorker displays a new window, similar to that shown in Figure 4-20.

Figure 4-20 Recover Volumes Required Window

If the backup volume is available, which means the volume is mounted or in an
autochanger, “all on-line” message appears in the Recover Volumes Required window.
The window displays the name(s) of the backup volume(s) and, if applicable, their
location.  In the example shown in Figure 4-20, the volume midas.apr96.003 is offline,
the volume midas.apr96.005 is in the DLT library, and the volume midas.apr96.008 is
in the drive named /dev/rmt/tps6d6nrnsv.
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Relocating Files

To recover files to a directory other than the one they were backed up from, use the
Relocate menu item before you start the recover.  The Relocate operation creates a directory,
if it does not already exist, and recovers your file to the new location.

To relocate recovered files into a new or existing directory:

1. Choose Relocate from the Options menu in the NetWorker Recover window, shown by
Figure 4-21.

Figure 4-21 Options Relocate Menu Choice

2. Enter the complete pathname of a directory where you want to place the recovered
files into the Relocate to field, as shown in Figure 4-22.

Figure 4-22 Relocate Window

3. Click Ok to relocate the files into the new directory.

Renaming or Overwriting Recovered Files

When you start a recover, NetWorker displays the Conflict Resolution dialog box.  You must
decide whether to rename recovered files or overwrite existing files when a naming
conflict occurs.  A naming conflict occurs when a file you are recovering already exists or
has the same name as a file in the current directory.  NetWorker will not overwrite
existing files unless requested to do so.
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The Conflict Resolution dialog box has two sections requiring a selection for resolving naming
conflicts, as shown in Figure 4-23.

Figure 4-23 Conflict Resolution Dialog Box

1. Choose a response for the Do you want to be prompted when conflict occurs? question.  The
default choice, Yes, is already highlighted.

Clicking No allows you to resolve conflicts for the entire recover session without
being prompted about individual files.  If you choose No, you must also choose a
response for the When conflict occurs, NetWorker should? question.

Clicking Yes allows you to resolve conflicts on for each file.  NetWorker prompts for
instructions in the Filename Conflict dialog box every time it encounters a naming
conflict.  Each time this occurs, select a choice for the Do you want to? question in the
Filename Conflict dialog box, as shown in Figure 4-24, then click the Ok button.

Figure 4-24 Filename Conflict Resolution Dialog Box
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The following are choices for conflict resolution:

Rename the recover file—NetWorker renames the recover file with a .R extension.  If a .R
file exists, NetWorker adds another .R extension to the recover filename.

Discard the recover file—NetWorker discards the recover file.  The existing file remains
where it was.

Overwrite the existing file – NetWorker replaces the existing file with the recovered file.
The existing file is lost and the recovered file becomes current.

2. Click Ok to continue the recover after completing the Conflict Resolution dialog box or
click Cancel to return to the NetWorker Recover window.

Monitoring the Recover Status

After the Conflict Resolution dialog box closes, the Recover Status window re-appears, as shown
in Figure 4-25, and the recover continues.

Figure 4-25 Recover Status Window (Relocate)
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The Recover Status dialog box provides you with the following information about your
recover session:

• The number of files to be recovered and where they will be relocated. If you
specified a directory in the Relocate dialog box, it is listed:

Recovering 6 files within
/usr/people/tut/books/2000/007-2304-003/online/ into
/usr/people/tut/Reports

• The estimated disk space required for the recover:

Total estimated disk space needed for recover is 53 KB.

• The name of the required backup volume and its location:

Volumes needed (all on-line):
    midas.apr96.008 at /dev/rmt/tps6d6nrnsv

• The number and names  of files or directories being recovered:

Requesting 6 files, this may take a while...

• The new filenames, if you chose to rename recovered files, and a summary:

Received 6 files from NSR server `midas'
Recover completion time: Fri Apr 19 17:29:45 PDT 1996

To cancel the recover or to close the Recover Status dialog box, click the Cancel button.  When
the recover completes, a message showing the recover completion time appears in the
Recover Status dialog box.

Recover Shortcut

Read this section if you are already familiar with the NetWorker Recover window.

To recover your directories or files:

1. Click the nwrecover icon to open the NetWorker Recover window.

2. Change servers, if necessary, by clicking the Change Server speedbar button.  If
applicable, change clients by choosing Client from the Change menu.

3. Use the mouse to highlight the icons for files or directories you want to recover, then
click the Mark speedbar button.

4. Choose Volumes from the View menu to see if the backup volumes are immediately
available for your recover.
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5. Click the Start speedbar button to begin the recover.

6. Click the Ok button in the Conflict Resolution dialog box.

7. Click the Cancel button to close the Recover Status dialog box after the recover
completion time message appears.

Summary of Backup and Recover

To use NetWorker successfully, you must be able to perform the following tasks:

• back up files

• monitor the backup status

• view the backup volumes needed for a recover

• recover files

• relocate or rename files during a recover

• monitor the recover status

For information about configuring the NetWorker server, refer to the IRIX NetWorker
Administrator‘s Guide or ask your system administrator.

The next chapter, “Archiving and Retrieving Files,” explains how to use the optional
Archive Application.
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5. Archiving and Retrieving Files

This chapter describes how to archive and retrieve files and directories using the optional
NetWorker Archive Application.

Archiving Files

Backup and archive serve different purposes.  Backup is short-term insurance against
data loss.  NetWorker keeps track of backups in the online file index to enable users to
quickly recover lost or corrupted files.  This online file index requires considerable disk
space.  Because archives theoretically are kept forever, NetWorker does not track them in
the online file index—NetWorker only tracks archives in the online media index.

Archive is a long-term strategy for preserving data on media called archive volumes.
Archive volumes are similar to backup volumes, except they do not have an expiration
date, which simply means that NetWorker will keep track of them forever.

Once files are safely stored on archive volumes, the archived files can be removed from
local disk, freeing up space on your system.  If you ever need to restore archived files to
your system, you may do so at any time using the NetWorker Retrieve window.

To a user, archiving files is like backing up files, except that an Archive application allows
you to automatically groom archived files and directories.  Grooming means that files
and directories are optionally deleted from your filesystems after they have been
successfully archived.

To a system administrator, backup has a different purpose than archive.  The goal of
backing up filesystems is to protect against loss of data due to hardware failure or user
error.  The goal of archiving is to make more space available on disk while maintaining
a snapshot of removed files for quick retrieval in the future.

Since archived files are not tracked in the online file index, the NetWorker Retrieve window
does not display archived files and directories in the same manner as other NetWorker
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windows.  Archives made on the server appear in alphabetical order in the Archives
display of the NetWorker Retrieve window.

Tip: The best way to remember what an archive contains is to record the date and create
a meaningful annotation.  See “Starting an Archive” on page 57 for details.

Starting NetWorker Archive

If the Archive Application is running on your system, you see the nwrchive icon or the
NetWorker Archive window on your screen.

Click the icon shown in Figure 5-1 to open the window.

Figure 5-1 NetWorker Archive Icon

If you do not see the nwarchive icon or the NetWorker Archive window, start the application from
a command line on your system.

To start the Archive Application from a command line, enter the nwarchive command,
followed by the server name and an ampersand (&) to run the application in the
background:

# nwarchive -s server_name &

If you have a multi-server network and do not specify a server name, NetWorker chooses
an archive server for you.

The NetWorker Archive window appears, as shown in Figure 5-2.
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Figure 5-2 NetWorker Archive Window

Starting an Archive

To start an archive:

1. Change archive servers, if needed.  The Change Server button is described in Chapter 4,
“Backing Up and Recovering Files.”

2. Mark the directory or files you want to archive.

Tip: Marking a directory also marks all the subdirectories and files it contains.  If you
want to archive most (but not all) files in a directory, first mark the directory, then
unmark files you do not want to archive.
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3. Click the Start speedbar button, or choose Start Archive from the File pulldown menu.
The Archive Options dialog box appears, as shown in Figure 5-3.  The Archive Title field
shows the pathname of the currently selected directory or file.

Figure 5-3 Archive Options Dialog Box

4. Type a comment in the Annotation field that will help you remember the contents of the
archive for future retrieval.  When choosing a meaningful annotation, keep in mind
that annotation searches are case-sensitive.  The Annotation field accepts up to 1024
characters, including spaces and punctuation.

Note: If you do not enter an annotation before starting the archive, a dialog box
appears, as shown in Figure 5-4, reminding you to enter an annotation.

Figure 5-4 Notice to Enter Annotation
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5. Specify a volume pool for your archive in the Archive Pool field.  Click the arrow button
next to the Archive Pool field to view a list of the choices available.  Click the arrow
button again to close the list.

If an archive pool is not specified, the volume pool defaults to “Archive.”  If you do
not know which pool to choose, contact the system administrator.

6. Click any of the available options in the Operations list.  If the box next to an option is
highlighted, the option is selected.  The following choices are available options:

• Compress—to compress archive data, click Compress.  If you have a compressing
tape drive, do not choose the Compress option.

• Clone—to clone archive data on a different archive volume, click Clone.  NetWorker
makes a copy of your archived data.

• Verify—to verify that the data on archive media matches the data on local disk,
click Verify.

• Groom—to remove files and directories from local disk after archiving is
complete, click Groom.

See the sections following these instructions for an explanation of the Clone, Verify, and
Groom options.

7. Click the Archive button when you are ready to continue.  The Archive Status dialog box
appears, showing the archive process.

Click Cancel if you need to stop the archive process.  A dialog box appears, as shown
in Figure 5-6, asking for confirmation.

Figure 5-5 Notice to Cancel Archive

Click OK to terminate the archive, or Cancel to continue.
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Cloning Your Archive

Cloning makes a duplicate copy of your archive.  Two backup devices are required to
make a clone.  Each backup device must have a valid, writable archive volume mounted.
Check with your system administrator before making clones of your archives.

When you select Clone in the Archive Options dialog box, NetWorker duplicates your archived
data on another archive volume.  If you specify a Clone Pool, the archive clone is sorted to
a volume associated with that pool.  Otherwise, the archive clone goes to “Archive
Clone,” the default clone pool,

Click the arrow button next to the Clone Pool field to view a list of the choices available.
Click the arrow button again to close the list.

Verifying Your Archive

When you select Verify in the Archive Options dialog box, NetWorker checks the data written
on the archive volume.  If you also select Clone in the Archive Options dialog box, the clone
volume is verified.  The archive completion report in the Archive Status dialog box alerts you
to any problems with the archived or cloned data.

Grooming Your Filesystem

When you select Groom in the Archive Options dialog box, NetWorker deletes all marked files
after the archive successfully completes.  Select the Verify option when you choose Groom to
ensure that files are properly archived before they are groomed from your disk.

Caution: When you select the Groom option, be careful not to mark any files that you must
retain on disk.  Check with your system administrator before using the Groom option.
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Monitoring the Archive Status

Use the Archive Status window, shown in Figure 5-6, to monitor the archive process.

Figure 5-6 Archive Status Window

The Archive Status window provides the archive start time and the archive completion time.
The names of the archived files and directories scroll across the Archive Status window as
the archive proceeds.  When the archive completes, the full pathname of the archived
directory, the amount of data, the amount of time it took, and the number of files archived
are displayed.  The Archive Completion Information field gives you details about the archive,
including the volume to which your save set was archived, and the annotation you
assigned to the archive.

Tip: Write down the annotation and volume information and include it with your project
documentation to make it easier to retrieve the data at a later date.
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Retrieving Files

Retrieval involves the copying of files back to local disk from archive volumes.

Starting NetWorker Retrieve

If the retrieve utility for the Archive Application is running on your system, you see the
nwetrieve icon or the NetWorker Retrieve window on your screen.

Click the icon shown in Figure 5-7 to open the window.

Figure 5-7 NetWorker Retrieve Icon

If you do not see the nwretrieve icon or the NetWorker Retrieve window, start the application
from a command line on your system.

To start NetWorker Retrieve from a command line, enter the nwretrieve command,
followed by the server name and an ampersand (&) to run the application in the
background:

# nwretrieve -s server_name &

If you have a multi-server network and do not specify a server name, NetWorker chooses
a retrieval server for you.

The NetWorker Retrieve Window

The NetWorker Retrieve window has fewer menus than the other NetWorker windows.  Since
archived save sets are not maintained in the online file index, the Tree, View, and Mark menus
are not present.  The File, Change, Options, and Help menus are navigated in the same manner
described for the NetWorker Backup, NetWorker Recover, and NetWorker Archive windows.

When you start the nwretrieve command, the Archives scrolling list is empty at first.  The
currently selected server is indicated directly beneath the speedbar.
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To display a list of archive save sets available on the currently selected server, click the
Query button.  The window displays a list of the archived save sets available for retrieval,
as shown in Figure 5-8.

Figure 5-8 NetWorker Retrieve Window

To search for a particular save set using all or part of its annotation, enter all or part of
the annotation in the Search annotation for field and click the Query button.  All archive save
sets with matching annotations appear highlighted in the Archives list.

Tip: Since the search for annotations is case sensitive, use regular expressions like [Aa]
to search for upper or lower case.
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Archive Save Set Details

To see details about the currently highlighted archive save set, click the Details button.  The
Retrieve Details window appears, as shown in Figure 5-9.

Figure 5-9 Retrieve Details Window

The fields in this window provide the following information:

• name—full name of the save set (including path)

• date—date the save set was archived

• files—number of files in the save set

• ssid—save set ID

• size—file size, in bytes

The Retrieve Details window also shows the archive annotation, which can be used in the
Search annotation for field in the Networker Retrieve window.

Note: The currently-highlighted save set is the only one whose details are displayed in
the Retrieve Details window.  To view the details of another save set without exiting the
Retrieve Details window, highlight the new save set in the Archives list.

Retrieving a Save Set

To retrieve a save set to your system:

1. Click the line containing the required save set in the Archives list in the NetWorker Retrieve
window.
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Tip: You may select multiple save sets for retrieval.  To avoid overwriting later
copies of files when the Overwrite existing files option is selected, NetWorker retrieves the
files in chronological order.

2. Select Start Retrieve from the File menu.

The Retrieve Status dialog box appears, as shown in Figure 5-10.  The Archives list
displays all the archive save sets you selected for retrieval in the Networker Retrieve
window.

Figure 5-10 Retrieve Status Dialog Box

3. Specify a new or existing directory in the Relocate to field, if needed.  By default,
retrieved files are copied to their original location.

4. Click Overwrite existing files, if you want NetWorker to replace existing files on the local
disk with files retrieved from the archive volume.  If you do not select this option,
NetWorker prompts you to resolve naming conflicts.

5. Click the Ok button when you are ready to start the retrieve.  The appropriate
archive volume(s) must be mounted (mounting is automatic in an autochanger).
During a retrieve operation, messages appear under Status to inform you of progress,
as shown in Figure 5-11.
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Figure 5-11 Retrieve Status After Success

To stop a retrieve in progress, or to dismiss the Retrieve Status dialog box before
retrieval has begun, click the Cancel button.

Summary of Archiving

Archiving files is like placing them into a bank safe deposit box.  They are meant to
remain safe and last forever.  But just as paper in safe deposit boxes can age and yellow,
tapes used to archive files do not last forever.  Optical discs last longer, but are still
vulnerable to fire.  Choosing the Clone option, which makes an extra copy of the archive,
increases the protection of vital data.

Deleting files from disk, using the Groom option, conserves the space for current projects.
However, if your site policy is to move archives offsite for increased protection,
retrieving archived files could take awhile.  Contact your system administrator to find
out whether the archive volume you need is available for immediate retrieval.
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A. Error Messages

NetWorker provides user-friendly error messages with instructions to help you solve
most backup, archive, and recover problems you encounter.

Error Messages for Backup and Archive

NetWorker displays an error message if a backup or archive cannot be completed.

Table A-1 Backup and Archive Error Messages

Message Cause Solution

Nothing marked for
backup.

You started a backup
without marking any files.

Mark at least one file before
starting the backup or archive.

Unable to start backup. NetWorker was unable to
execute the save command.

Contact the system administrator.
There is a problem with the
NetWorker software or your client
configuration

Your system is not a
registered client.

The server you selected
does not have your system
listed as a NetWorker
client.

Contact the system administrator.
Your system needs to be added to
the list of recognized clients for the
selected server.
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Error Messages for Recover and Retrieve

NetWorker displays an error message if it cannot recover or retrieve a file.

Table A-2 Recover and Retrieve Error Messages

Message Cause Solution

These are files marked for
recovery.  Continue to ignore the
marked files, or cancel to stay
with this client.

You tried to change
clients or filesystems
after marking some
files for recover or
retrieve.

You have the option to continue
changing the client. In this case, the
marked files will not be recovered.
Or you can cancel to stay with the
current client and retain your
marked files.

(For root users)
Only 10 KB available to
non-superusers (15 KBytes free)
in /directory. Filesystem will be
greater than 100% full after
recover is complete.
Proceed with recover command
at this time? [n]

(For non-root users)
No disk space available to
non-superusers (15 KB free) in
/directory. The estimated recover
size of 10 KB will not fit on this
filesystem.
Proceed with recover command
at this time? [n]

There is not enough
free space in the
filesystem to recover or
retrieve the requested
files.

Reduce the size of the recovery by
reducing the number of marked
files.  Relocate the recovered files
into another directory with more
space.  If you are recovering over
existing directories, you may be able
to proceed with the recovery since
files will be overwritten.

Invalid time format. The time you entered in
the Browse Time field was
an invalid format.

Enter the browse time using a valid
format.  Examples of valid browse
time formats are shown on page 46
of this guide.
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Error Messages for All

Some NetWorker error messages are the same for an unsuccessful backup, recover,
archive, or retrieve.

Nothing in index at this time. There are no entries in
the index for the
browse time that you
specified, or no
backups were done at
that time.

Enter another browse time until you
find the index entries for which you
are looking.

Unable to relocate to /directory. NetWorker was unable
to relocate the
recovered data to the
path you specified.

Enter a valid pathname in the Relocate
dialog box and start the recovery
again.  You must have write
permission for the directory you
wish to use.

Table A-3 General NetWorker Error Messages

Message Cause Solution

There are files marked for
backup or recovery.
Continue to ignore the
marked files or cancel to
stay with server.

You cannot change servers
after you have marked
files.

You have the option to continue
changing servers.  If you change
servers, the marked files will not
be backed up or recovered.  You
can cancel to stay with the current
server and retain your marked
files.

Bad start path. You specified an invalid
starting path for a search.

Enter a valid pathname as a start
path in the Search dialog box.

No match. The Search command did
not find any matches.

Enter a different search pattern or
starting path.

Table A-2 (continued) Recover and Retrieve Error Messages

Message Cause Solution
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Bad search pattern. The search pattern you
specified is not valid.

Use UNIX shell pattern matching
characters to specify a search
pattern.

Unable to expand path. The path you specified in
the Selection field does not
correspond to anything in
the index or filesystem.

Enter a valid pathname in the
Selection field.

Table A-3 (continued) General NetWorker Error Messages

Message Cause Solution
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B. NetWorker UNIX Shell Commands

In addition to a graphical user interface (GUI), NetWorker has UNIX style commands.
These commands are entered from a UNIX shell to back up and recover data.  You must
have access to a NetWorker server and your system must be configured as a NetWorker
client in order to use these commands.

Both the save and recover commands can be run with arguments from the command
line.  Refer to the save(1M) and recover(1M) reference pages for more information about
saving and recovering data from the command line.

Enter the save command at the system prompt to back up data:

# save -s server pathname

Enter the recover command at the system prompt to recover data:

# recover -s server -c client pathname

Table of Recover Commands

The recover program provides an interface that allows you to browse files and control
recovers.  When you enter the recover command, the NetWorker prompt appears.

Table B-1 shows recover program commands to enter at the NetWorker prompt.

Table B-1 NetWorker Recovery Commands

Command Description

add filename Add filename to the recover list.

cd dir Change directory to dir.

changetime Change the browse time of online index.
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delete filename Delete filename from the recover list.

dest Verify destination directory for recovered files.

force Overwrite existing files.

help or ? Display list of recover program commands.

list List the files in the recover list.

ls -f (or -lf) filename List filename with file type information.

ls -l (or -ll) filename List filename using long format.

ls filename List filename.

noforce Do not overwrite existing files.

nsrwatch Monitor NetWorker server activity.

pwd Display name of current directory.

quit Exit the recover program.

recover Start the recover program when entered at the system prompt;
start the recovery when entered at the recover> prompt.

relocate dir Specify new directory location for recovered files.

verbose Toggle verbose or quiet mode for recover status messages.

versions filename Display backup history of filename
filename can be either a file or a directory.

volumes filename List volumes needed to recover marked files
filename can be either a file or a directory.

Table B-1 (continued) NetWorker Recovery Commands

Command Description
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archive

A snapshot of a file or directory as it currently exists.  An unlimited expiration date
allows for long-term storage and retrieval.

archive volume

Any type of storage media (tape or optical disc) that can be used for long-term storage.

autochanger

A robotic device with the ability to automatically move, load, and store a collection of
volumes.  These allow NetWorker to operate without administrative intervention.

backup

A copy of your workstation data stored on tape or optical disc.

backup device

The device attached to the NetWorker server for backing up and recovering data.  For
example:  8 mm and 4 mm tape drives, optical drives, and autochangers.

backup volume

Any type of storage media (tape or optical disc) that your server can use for backup.

browse time

Viewing specification for files backed up at a specific time.  For example, a browse time
of 09/13/95 24:00 yields a view of files backed up at midnight on 9/13/95 and before.

collapse

Changing the display to show only the parent of a directory in the NetWorker Backup, NetWorker
Recover, and NetWorker Archive windows.

expand

Changing the view to display all levels of a directory in the NetWorker Backup, NetWorker
Recover, and NetWorker Archive windows.
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file index

A database on the NetWorker server containing an entry for every backed-up file.

media index

A database on the NetWorker server containing entries for all the volumes backed up
and archived by the NetWorker server.

NetWorker client

A system on your network that backs up and recovers data using NetWorker.

NetWorker server

A system with a backup device that backs up systems configured as NetWorker clients
across the network.  The server backs up the systems according to a schedule set by the
system administrator.  The server maintains an index of all the backed-up data and the
volumes the backed-up data is stored on.

recover

Replace a lost or damaged file from a copy stored on a NetWorker backup volume.

save set

A set of files backed up or archived by NetWorker on a backup or archive volume.

selection

The name of the volume, directory, or file highlighted in a NetWorker window.

tree structure

A display of files in the Backup, Recover, and Archive windows in hierarchical format.

volume

A unit of media used for backup, such as a magnetic tape or an optical disc.

volume pool

A feature that sorts your backup and archive data to selected volumes.  A volume pool
contains a collection of files sorted during the save process by criteria set by the system
administrator.
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backup volume, locating,  43
block device icons,  13
browse time,  45
Browse Time field,  45, 46, 68
Browse Time menu item,  45, 46
browsing

changing time,  46
file index,  21
filesystem,  14
index,  22
selecting level of,  27
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Query,  63
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C

calendar for Change Browse Time,  46
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a backup,  38
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Change Client dialog box,  41
Change pulldown menu,  34, 45
Change Server dialog box,  34
Change Server menu item,  34, 57
Change Server speedbar button,  34
changetime recover command,  71
changing a selection,  32
changing the browse time,  45, 46
changing the NetWorker server,  33
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choosing a recover server,  40
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D
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Backup Status,  19, 38, 39
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Exit menu item,  13
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expanding directories,  15
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files,  14, 28
files for recovery,  21
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Quick Tour

review,  26
starting point,  14

quit recover command,  72

R

recover
command table,  71
files, deleted,  45
preparing to,  39
volumes needed,  25, 48

recover command,  72
Recover Status dialog box,  24, 52
Recover Volumes Required dialog box,  49
reducing NetWorker traffic,  19, 36
Relocate dialog box,  69
Relocate menu item,  50
relocate recover command,  72
Relocate to field,  65
renaming or overwriting recovered files,  50
Retrieve Details dialog box,  64
Retrieve Status  dialog box,  65

S

scrollbar,  11
Search annotation for field,  63
Search dialog box,  30, 69
searching for files,  30
Search menu item,  30, 69
Search speedbar button,  29
selecting

archive volume pool,  59
clone volume pool,  60
versions of directories,  45
versions of files,  42, 44

Selection field,  11, 32, 70
Server field,  34
Server pulldown menu,  40
sheet icons,  13
Show Marked menu item,  47
speedbar buttons

Change Server,  34
Mark,  29
Search,  29
Start,  35
Unmark,  29

Start Archive menu item,  58
Start Backup menu item,  35
starting NetWorker

Archive,  56
Backup,  5
pathname of directory,  6, 15
Recover,  5
Retrieve,  62

Start Recover menu item,  24, 40
Start Retrieve menu item,  65
Start speedbar button,  35
Status field,  65
symbolic link icons,  13
symbols in User’s Guide,  xiv



80

Index

T

Topics Help dialog box,  8
Tree pulldown menu,  27
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U

UNIX
shell pattern characters,  30, 37
shell tool,  24

unmarking files,  18, 29
Unmark menu item,  18
Unmark speedbar button,  29
Update Server List button,  34
User’s Guide, symbols,  xiv

V

valid browse time formats,  46, 68
verbose recover command,  72
Verify menu item,  60
Versions dialog box,  42, 44, 45
versions recover command,  72
viewing

backup times,  31
directories,  27
file details,  31
files in the past,  45
selecting detail, level of,  29

View pulldown menu,  29, 42, 48
Volumes menu item,  48
volumes recover command,  72

W

watch icon,  13
windows

controls,  11
NetWorker Archive,  56
NetWorker Backup,  6
NetWorker Recover,  21, 39
NetWorker Retrieve,  62
using,  6
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